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Release Notes for 
Lattice Diamond 3.1

Welcome to Lattice Diamond®, the complete design environment for Lattice 
Semiconductor FPGAs. Lattice Diamond design software offers leading-edge 
design and implementation tools optimized for cost-sensitive, low-power 
Lattice FPGA architectures. Diamond is the next generation replacement for 
ispLEVER®, featuring design exploration, ease of use, improved design flow, 
and numerous other enhancements. Diamond is available for both the 
Windows and Linux operating systems. For details, see “System 
Requirements” on page 9.

This version of Diamond adds a variety of enhancements to make designing 
for Lattice Semiconductor programmable devices easier than ever. The 
design tools also include support for the latest Lattice Semiconductor devices. 
See “What’s New” on page 2.

Lattice Semiconductor offers a rich variety of information sources, including 
the Help system, PDF manuals, tutorials, and online discussions. The easiest 
way to reach them all is through the online Help. The first topic in the Help 
provides links to all the other sources of information.

You can also find extensive information about Diamond, it’s capabilities, tools, 
and workflow on the Lattice Semiconductor Web site under:

www.latticesemi.com/latticediamond

../webhelp/eng/index.htm?context=Getting_Started&topic=Getting_Started
http://www.latticesemi.com/latticediamond
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What’s New
This release of Diamond provides a variety of new features in the following 
areas. See the online Help for details. Also see “Issues Fixed” on page 11 for 
known issues of the previous release that have been fixed.

New Device Support The following new devices are available with device 
programming enabled:

 MachXO3L

Documentation A new Programming Tools User Guide has been added. 
This document provides high-level descriptions of the major Diamond 
programming tools including Diamond Programmer, Deployment Tool, 
Programming File Utility, Model 300, and the driver installation utility. This 
document also contains extensive technical information on Lattice Embedded 
VME, which consists of JTAG Full VME Embedded, JTAG Slim VME 
Embedded, Slave SPI Embedded, I2C Embedded, and sysCONFIG 
Embedded types. This embedded chapter combines and updates content that 
was previously contained in separate Technical Notes.

A printable PDF version of the FPGA Libraries Reference Guide is available 
at <install_dir>/docs/manuals/fpga_library.pdf. The PDF version is identical to 
the guide in the online help.

EPIC The EPIC user interface has been redesigned.

IPexpress IPexpress™ includes updates to many modules. For more 
information, open the online Help and go to Lattice Module Reference Guide.

LatticeMico System LatticeMico™ System updates include: 

 Updates to SDRAM controller (v3.8), SPI Flash (v3.5), GPIO (v3.5), Fault 
Logger (v1.1), and EFB (v1.5) components.

 Programmer cable names have been changed throughout.

 An additional LatticeMico32 Optimization option: Optimization Level 
s(-0s), has been added to LatticeMico32 SPE.

For more information, refer to the “LatticeMico System Software Release 
Notes for Diamond.” To access the release notes:

 If LatticeMico System is installed with Diamond, go to the Windows Start 
menu and choose Programs > Lattice Diamond > Accessories > 
LatticeMico System Release Notes.

 If LatticeMico System is installed as a stand-alone tool, go to the Windows 
Start menu and choose Programs > Lattice Diamond > LatticeMico 
System Release Notes.

Main Window The Process > Refresh Process command has been 
changed to the more complete Design > Refresh Design. The new command 
not only refreshes the Process view after changing a source file, but also 
updates the Hierarchy view, HDL Diagram, and Reveal Inserter.

fpga_library.pdf
../webhelp/eng/index.htm?context=IPexpress&topic=intro
programming_ug.pdf
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The new File > Save Project As command saves a copy of the whole design 
project under another name. This can be an easy way to start another, similar 
design.

Messages You can promote warning messages to the error level so that 
warnings that are especially important to you are easier to spot. For more 
information, open the online Help and go to Managing Projects > Viewing 
Logs and Reports > Changing Warnings to Errors.

Platform Designer Platform Designer's new Hot Swap utility enables you to 
configure a component for controlling the in-rush current in applications where 
power is rapidly applied. Such an application can include a line card, blade, or 
a PCB that is plugged into a “hot” backplane. For more information, open the 
online Help and go to Designing with Lattice Diamond Platform Designer > 
Configuring Hot Swap.

Programmer Programming File Utility has been enhanced. You can now 
edit Feature Row Fuse settings for MachXO2, MachXO3L, and Platform 
Manager 2 devices; edit Control Register0 values of a bitstream file; and edit 
USERCODE in the data file. For more information, open the online Help and 
go to Programming the FPGA > Using Programming File Utility.

Programming Cable Names Lattice USB and Parallel cables have been 
renamed as follows:

Reports The Map report has been enhanced to show the number and 
percentages of resources used out of the total resources in the device. For 
more information, open the online Help and go to Implementing the Design > 
Mapping > MAP Report File.

Reveal Reveal Analyzer has the following enhancements:

 It can avoid the test-logic-reset JTAG state when using a USB cable. 
JTAG chains that require the assertion of TRST can get out of sync when 
using Reveal. When starting Reveal Analyzer with a new file, select Avoid 
TLR State.

 The minimum frequency of the sample clock has been reduced from three 
times the JTAG clock to the same as the JTAG clock.

Simulation (Windows version) The Aldec® Active-HDL™ Lattice Edition 
simulator has been updated.

Table 1: New Programming Cable Names

Old Cable Names New Cable Names New Complete Cable Names

USB HW-USBN-2A Lattice HW-USBN-2A USB port 
programming cable

USB2 HW-USBN-2B (FTDI) Lattice HW-USBN-2B (FTDI) USB 
programming cable

Lattice HW-DLN-3C (Parallel) Lattice HW-DLN-3C parallel 
programming cable

../webhelp/eng/index.htm?context=Design_Implementation&topic=map_report_file
../webhelp/eng/index.htm?context=Design_Implementation&topic=map_report_file
../webhelp/eng/index.htm?context=Managing_Projects&topic=promoting_messages
../webhelp/eng/index.htm?context=Managing_Projects&topic=promoting_messages
../webhelp/eng/index.htm?context=Power_Management&topic=configuring_hot_swap
../webhelp/eng/index.htm?context=Power_Management&topic=configuring_hot_swap
../webhelp/eng/index.htm?context=Device_Programming&topic=Using_Programming_File_Utility
../../active-hdl/BOOKS/RelnotesLattice.chm
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Synthesis Tools The Synopsys® Synplify Pro® for Lattice and Lattice 
Synthesis Engine (LSE) synthesis tools have been updated.

LSE supports the new MachXO3L devices.

LSE supports VHDL2008. To use this version of VHDL, go to the LSE 
strategies and set VHDL 2008 to True.

Selection of a synthesis tool is now done directly in the Project Properties 
dialog box. For more information, open the online Help and go to Managing 
Projects > Setting Options for Synthesis and Simulation > Selecting a 
Synthesis Tool.

Supported Devices
Lattice Diamond can be used with either a free license or a subscription 
license. The two licenses provide access to different device families.

Device Family Free License Subscription License

ASC  

LatticeEC™  

LatticeECP™  

LatticeECP2™  

LatticeECP2M™ 

LatticeECP2S 

LatticeECP2MS 

LatticeECP3™ 

LatticeSC™ 

LatticeSCM™ 

LatticeXP™  

LatticeXP2™  

MachXO™  

MachXO2™  

MachXO3L  

Platform Manager™  

Platform Manager 2  

../webhelp/eng/index.htm?context=Managing_Projects&topic=selecting_a_synthesis_tool
../webhelp/eng/index.htm?context=Managing_Projects&topic=selecting_a_synthesis_tool
../webhelp/eng/index.htm?context=Managing_Projects&topic=selecting_a_synthesis_tool
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Updating Projects from an Earlier Version
If you want to work on a design project created with an earlier version of 
Diamond, start with the following procedures. These procedures adapt the 
project for the changes in Diamond.

Find out which version of Diamond your project was created with. Then work 
through the changes for that and every later version, starting with the earliest 
and going to the most recent. For example, if your project was created with 
Diamond 1.1, you would start with the changes for 1.1. After completing those 
changes, you would work on the changes for 1.2, then 1.4, and so on.

When you open a project from Diamond 1.2 or earlier, Diamond opens a 
dialog box warning that Diamond will automatically move all SDC files to the 
Synthesis Constraint Files folder in File List view and remove the “Input SDC 
Constraint File” options from the strategies. If the project is using LSE, the file 
names will be changed to use an .ldc extension.

Once saved, the project will not be compatible with earlier Diamond versions.

2.0.1 Projects
The default values of several strategy options were changed. If you are using 
Synplify Pro in integrated mode (running synthesis automatically in Diamond), 
check that the following settings are still as you want them. Also, check the 
setting of the Auto Hold-Time Correction option under Place & Route Design. 
Its default changed to On for all devices.

Table 2: New Default Values for Synplify Pro for Lattice

Option Before Now

Fanout Limit is now Fanout 
Guide

100 1000

Export Diamond Settings to 
Synplify Pro GUI (new in 2.2)

Not available No

Fix Gated Clocks and Fix 
Generated Clocks combined 
into new Clock Conversion

3 (converts and reports all 
sequential elements)

True (converts with no 
report)

Frequency 200 auto (blank means “auto”)

Number of Critical Paths 3 blank (unspecified)

Number of Start/End Points 0 blank (unspecified)

Output Preference File False True

Pipelining and Retiming False Pipelining Only

Resolved Mixed Drivers True False

Use Clock Period for 
Unconstrained I/O

True False



Updating Projects from an Earlier Version

6 Release Notes for Lattice Diamond 3.1

1.4 Projects
For Diamond 1.4 and earlier, there might be some constraints that are not 
honored because of the Synplify Pro cross-probing feature. This EDIF 
renaming is usually related to bus names.

If such a problem occurs, you can turn off the renaming feature by placing the 
following line in the “Command line Options” text box of the Synplify Pro 
section of the active strategy:

set_option -syn_edif_array_rename 0

1.2 Projects
There were several enhancements for IP and MachXO2.

IP Incompatibilities
SPI4.2 2.7 is not compatible with Diamond 1.3 or later. If you are using this IP, 
check the Lattice Semiconductor Web site for a more recent version.

MachXO2 Changes
See if your design involves any of the following features:

 For EFB modules with user flash memory (UFM), regenerate the module.

 For IO_TYPE=PCI33 on a MachXO2-1200 or larger device, check if the 
CLAMP is using the default setting. With Diamond 1.3 the CLAMP default 
changes from ON to PCI and the I/O will be placed in bank 2. If you were 
using the default and still want the setting to be ON, you need to set it 
explicitly.

 For PCI33 MT 6.5 and PCI33 T 6.4 IP, either set the CLAMP to ON 
explicitly or choose a bigger package (256 or more).



Migrating ispLEVER Projects

Release Notes for Lattice Diamond 3.1 7

1.1 or 1.0 Projects
There were several enhancements for IP and MachXO2.

IP Incompatibilities
The following IP versions are not compatible with Diamond 1.2 or later. If you 
are using any of these IP, check the Lattice Semiconductor Web site for a 
more recent version.

MachXO2 Support
Some aspects of the software support for MachXO2 designs have been 
improved. See if your design involves any of the following features:

 The 4K/7K design with PLL has a CIB-to-PLL jump change. If you are 
using this design, recompile it.

 The EFB simulation model has changed. If you are using the EFB module, 
rerun your simulation tests to see more accurate results.

 In the DDR_GENERIC module of IPexpress, the GDDRX1_RX.Aligned 
with PLL interface is no longer supported. If you are using such a module, 
use IPexpress to regenerate it without the PLL option.

Also, MachXO2 has IP evaluation capability and TransFR mode for all I/Os.

Migrating ispLEVER Projects
Diamond uses a different project structure than ispLEVER and cannot directly 
open an ispLEVER project. However, design projects created in ispLEVER 
can easily be imported into Diamond. The process is automatic except for the 
ispLEVER process properties, which are similar to the Diamond strategy 
settings, and some modules and IPs. All of your ispLEVER project source will 
be automatically handled.

Projects created using ispLEVER can be imported into Lattice Diamond 
through two different paths:

 On the Start Page, click Import ispLEVER Project (in the upper-left 
corner).

 From the File menu, choose Open > Import ispLEVER Project.

 Convolution Block Encoder 3.6

 DDR1 6.9

 DDR2 7.1

 DDR3 1.2.1

 DDR1_CP 1.1 with MachXO2

 DDR2_CP 1.1 with MachXO2

 Interleaver Deinterleaver 3.5

 PCI_MT_33 6.4

 PCIe RC Lite 1.2

 Tri-Speed MAC 3.4

 Viterbi Block Decoder 4.6
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Follow the directions in the dialog box that opens to convert your ispLEVER 
project into a Lattice Diamond project.

Limitations to the import/conversion process include:

 NGO files in ispLEVER projects need to be manually copied into the 
Lattice Diamond project if the NGO files were originally copied into the 
ispLEVER project. For example, NGO files that were copied from Lattice 
IP generation.

 The .lpc files are replaced with .ipx files in Lattice Diamond. You need to 
regenerate your IP by double-clicking on the .lpc file. The resultant wizard 
will help you generate the new .ipx file, replacing the old .lpc file.

More information on importing ispLEVER projects can be found in the Lattice 
Diamond User Guide, online Help (see Managing Projects > Importing 
ispLEVER Projects), and training videos on the Lattice Web site.

Supported Third-Party Tools
This version of Diamond has been tested with the following third-party tools:

 Active-HDL™ 9.3

 Modelsim® (SE) 10.1c-se

 NC-Sim 11.10-s025

 QuestaSim 10.1a

 Riviera 2012.06

 Synplify Pro I-2013.09L

 VCS D-2010.06

Other Information Resources
Other available information resources for the Diamond software include the 
following.

 General Information: General information on Lattice Diamond can be 
found on the Lattice Web site at:

www.latticesemi.com/latticediamond

 Online Help: Start Lattice Diamond and choose Help > Lattice Diamond 
Help.

 Lattice Diamond User Guide: This document can be found from a link on 
the Start Page view.

 Training Videos: Several short videos are available on different aspects of 
the Lattice Diamond software. These can be viewed online at:

www.latticesemi.com/latticediamond

Click the Videos tab.

http://www.latticesemi.com/latticediamond
http://www.latticesemi.com/latticediamond
../webhelp/eng/index.htm?context=Managing_Projects&topic=importing_isplever_project
../webhelp/eng/index.htm?context=Managing_Projects&topic=importing_isplever_project
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System Requirements
The basic system requirements for Lattice Diamond are:

 Intel Pentium or Pentium-compatible PC, or AMD Opteron system support 
(Linux only)

 One of the following operating systems:

 Windows XP, Windows Vista (32-bit), or Windows 7 (32-bit or 64-bit).

Note: Windows 8 is not supported.

 Red Hat Enterprise Linux 4.X, 5.3, or 6. The host operating system 
can be either 32-bit or 64-bit. 

Version 5.3 of Red Hat Enterprise Linux has some extra installation 
requirements. See “Configuring Red Hat 5.3” on page 11.

 Novell SUSE Linux Enterprise 10 SP1 or 11 operating system. Novell 
SUSE Linux supports 32-bit only.

 Approximately 5.75 GB free disk space

 RAM adequate for your FPGA design. For guidelines see “Memory 
Requirements” on page 9.

 Network adapter and, for a floating license, network connectivity

A node-locked license is based on the physical (hard-coded) address 
provided by the network adapter. Network connectivity is not required for a 
node-locked license. In the absence of a network connection, you can 
install the NWLink IPX/SPX protocol to force recognition of your NIC card 
ID (see the installation notice).

A floating license requires access to the license server, so both a network 
adapter and connectivity are required.

 JScript-capable Web browser

 Acrobat Reader 5.0 or later

Memory Requirements
Table 3 lists the minimum memory requirements and the recommended 
memory for the Lattice Semiconductor devices supported by Diamond.

On Windows, designing for the largest FPGAs may require more than the 
usual 2 GB of memory found in 32-bit computers. For help in extending your 
memory to 3 GB, see “Extending Memory on Windows” on page 9. Designing 
for LatticeECP3 with more than 95K LUT on a Windows system requires a 64-
bit operating system.

Extending Memory on Windows
Designing for LatticeECP3 may require more than the 2 GB normally 
available with 32-bit Windows systems. But you can configure Windows to 
use up to 3 GB of memory.
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Note that increasing the amount of memory available to applications, 
decreases the amount available for the file cache, paged pool, and nonpaged 
pool, which can affect applications with heavy networking or I/O.

In Windows XP
In Windows XP Professional, add the /3GB switch to the end of the startup 
line in the boot.ini file. For details, see the following Microsoft articles:

 “Windows XP SP1 May Not Start with the /3GB or /USERVA Switch”:
support.microsoft.com/?kbid=328269

 “How to edit the Boot.ini file in Windows XP”:
support.microsoft.com/default.aspx?scid=kb;en-us;q289022

 “Memory Support and Windows Operating System” shows an example of 
the boot.ini with the /3GB switch:
msdn.microsoft.com/en-us/windows/hardware/gg487508.aspx

In All Other Versions of Windows
Use the BCDEdit /set increaseuserva 3072 command to set the boot entry 
option to 3 GB. For details, see Microsoft article “BCDEdit /set”:
msdn.microsoft.com/en-us/library/ff542202.aspx

Table 3:  Recommended Memory

Device Size 32-Bit Operating Systems 64-Bit Operating Systems

Minimum Recommended Minimum Recommended

LatticeEC, LatticeECP Up to 20K LUT 512 MB 768 MB 1 GB 1.5 GB

Up to 50K LUT 768 MB 1 GB 1.5 GB 2 GB

LatticeECP2/M Up to 20K LUT 768 MB 1 GB 1.5 GB 2 GB

Up to 50K LUT 1 GB 1.5 GB 2 GB 3 GB

Up to 100K LUT 1 GB 2 GB 2 GB 4 GB

LatticeECP3 Up to 95K LUT 2 GB 3 GB 4 GB 6 GB

Up to 150K LUT 3 GB 4 GB 6 GB 8 GB

LatticeSC/M Up to 40K LUT 768 MB 1 GB 1.5 GB 2 GB

Up to 115K LUT 1 GB 2.5 GB 2 GB 5 GB

LatticeXP, LatticeXP2 Up to 20K LUT 512 MB 768 MB 1 GB 1.5 GB

Up to 50K LUT 768 MB 1 GB 1.5 GB 2 GB

MachXO, MachXO2, 
MachXO3L

All 256 MB 512 MB 512 MB 1 GB

Platform Manager, 
Platform Manager 2

All 256 MB 512 MB 512 MB 1 GB

http://support.microsoft.com/?kbid=328269
http://support.microsoft.com/default.aspx?scid=kb;en-us;q289022
http://msdn.microsoft.com/en-us/windows/hardware/gg487508.aspx
http://msdn.microsoft.com/en-us/library/ff542202.aspx
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Configuring Red Hat 5.3
Red Hat Enterprise Linux 5.3 has some extra requirements for Diamond:

 In addition to the basic installation of Red Hat 5.3, under Development/ 
Legacy Software Development, select:

1:gtk+-1.2.10-56.el5.i386 - GIMP Toolkit (GTK+) sb:(9 of 9)

Under Base System/Legacy Software Support, add the following to the 
default items:

Openmotif22-2.2.3-18.i386 - Open Motif runtime

Proper Diamond operation depends upon these libraries being installed.

 When installing the Red Hat Enterprise Linux version, be sure to install the 
PERL modules XML::Parser, XML::DOM, and XML::RegExp. These 
PERL modules are available at www.cpan.org.

Issues Fixed
The following known issues are fixed with this release. Their workarounds are 
no longer needed.

Design Entry
Platform Designer displays Current Monitor trip 
points that are inconsistent with the datasheet
The trip points displayed in the Current Monitor Trip Point Selection menu 
differ, depending on the Hysteresis option selected. When Enabled is 
selected for Hysteresis, the trip points displayed are inconsistent with those in 
the datasheet. The correct trip points are those displayed when Disabled is 
selected, and the menus should be the same for both Enabled and Disabled 
hysteresis. 

Devices affected: Platform Manager 2
CR117823

Signal groups are not supported in the Platform 
Designer Generate Stimulus dialog box
In the Diamond Platform Designer, signal groups do not appear in the 
Generate Stimulus dialog box. To work around this issue, select individual 
group members one by one.

Devices affected: Platform Manager 2
CR102680

http://www.cpan.org
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Other Areas
VME file missing USERCODE verification opcode
Deployment Tool, with the Verify USERCODE option, does not include the 
opcode for USERCODE Verification test (case VUES = 0x61) at the beginning 
of the VME hex file.

Use ispVM System to generate the VME file instead.

Devices affected: All
CR117915

Debug Configuration operation may time-out over a 
slow Linux network
When running the Linux version of LatticeMico System software remotely 
over a slow Linux network connection, the Run > Debug Configuration 
operation may hang or display an “Unknown Device” error message.

The workaround is to debug your design using the LatticeMico System 
software installed on a local computer (PC or Linux), rather than running over 
a Linux network.

Versions affected: All LatticeMico System software versions
Devices affected: All
CR117821

The MachXO2 SEDFA simulation model does not 
contain timing requirements for the signal 
SEDFRCERR
The MachXO2 SEDFA simulation model does not contain timing requirements 
for the signal SEDFRCERR. 

Refer to the latest version of Lattice Technical Note TN1206 for the correct 
timing requirements. 

Device affected: MachXO2
CR58746
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Known Issues
Following are known issues with this release and workarounds for them.

Design Entry
Platform Designer rejects multiple hot swap 
components on an ASC
When you run DRC, after creating two or more hot swap components with fast 
shutdown enabled on the same ASC device, Platform Designer generates an 
error message similar to the following:

ASC_NONE can’t be used in HotSwap1 and HotSwap2 at the same time.

There is no workaround for this issue.

Devices affected: Platform Manager2
CR119823

Removing an implementation from Diamond does 
not delete the result files from the implementation 
directory
Removing an implementation from Diamond will not delete the result files 
from the implementation directory. 

Manually delete the files or the implementation directory if needed. If deleting 
the implementation directory, be careful to make sure that there are no source 
files in the implementation directory. 

Devices affected: All
CR48000

User Interface
Spreadsheet View takes a long time to open
For large projects, it might take a minute or longer for Spreadsheet View to 
open. This is because of the time needed for real-time PIO design rule 
checking as the design is loaded. 

Devices affected: All
CR56872



Known Issues

14 Release Notes for Lattice Diamond 3.1

Help does not work in Google Chrome browser
When you try to open the help with Google Chrome, the browser displays an 
empty window. If you get the help from a server it works fine, but if you get the 
help from your local computer there's nothing. 

This is because Google added a security feature in March 2010 that interfered 
with the file:// protocol, which is at the heart of browser-based help that 
Diamond and other Lattice software uses. (This affects the help of many other 
companies' software too.) 

Workarounds include: 

 Open a different kind of browser (such as Internet Explorer) and browse to 
the index.htm file of the software's help. 

 Set a different kind of browser as your default browser. 

 Install the Lattice software on a server. 

 Open Chrome from a command prompt with the following flag: 

chrome --allow-file-access-from-files 

Note: Doing this means that when you open any Web page that is 
resident on your computer—not just Diamond Help—the page will 
automatically run any active content that it has. While active content is 
common and can be very useful, malicious content can damage your files. 
Be sure you trust the software on your computer.

Devices affected: All
CR53868

Regions and groups in Physical View are not 
displayed in the colors assigned to them
Physical View displays only fixed colors for different elements such as 
regions, groups, sites, and delay paths. It does not support customized color 
settings. Therefore, the borders of all regions and groups are displayed in the 
same default color on the layout. They are not displayed in the colors that 
were assigned to them.

To view regions and groups in their assigned colors on the layout, open 
Floorplan View. 

Devices affected: All
CR50166

Physical View does not match delay path colors or 
allow custom colors
Physical View displays only fixed colors for different elements such as delay 
paths, regions, groups, and sites. Therefore, when you cross-probe a delay 
path from Timing Analysis View, Physical View highlights the path in the same 
default color. It does not show the path color that is displayed in Timing 
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Analysis View or allow you to manually change the color. Currently there is no 
way to distinguish the color of individual delay paths in Physical View. 
However, if you cross-probe to Floorplan View from Timing Analysis View, you 
will see the delay paths distinguished by color.

Devices affected: All
CR47031, CR49201

Other Areas
Reveal Analyzer fails to open on Windows 8
Diamond does not support the Windows 8 operating system. Reveal Analyzer 
fails to open.

Run Diamond on a different operating system.

Devices affected: All
CR118978

Synthesis fails with schematic file on Windows 8
Diamond does not support the Windows 8 operating system. Synthesizing a 
design with a schematic file fails with error code 1.

Run Diamond on a different operating system.

Devices affected: All
CR118394

PAR report does not show placement results sorted 
by timing score
When “Generate TRACE report for each iteration” has been enabled in the 
active strategy, the Place & Route report will show placement results sorted 
by “Worst Slack,” even when the “Timing Score” option has been selected for 
“Placement Sort Best Run.” 

Devices affected: All
CR59212
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Contacting Technical Support

FAQs The first place to look. The Answer Database provides solutions to 
questions that many of our customers have already asked. Lattice 
Applications Engineers are continuously adding to the Database.

Telephone Support Hotline Receive direct technical support for all Lattice 
products by calling Lattice Applications from 5:30 a.m. to 6 p.m. Pacific Time.

 For USA & Canada: 1-800-LATTICE (528-8423)

 For other locations: +1 503 268 8001

In Asia, call Lattice Applications from 8:30 a.m. to 5:30 p.m. Beijing Time 
(CST), +0800 UTC. Chinese and English language only.

 For Asia: +86 21 52989090

E-mail Support

 techsupport@latticesemi.com

 techsupport-asia@latticesemi.com

For Local Support Contact your nearest Lattice Sales Office.

Trademarks
Lattice Semiconductor Corporation, L Lattice Semiconductor Corporation (logo), L (stylized), L (design), Lattice 
(design), LSC, CleanClock, Custom Mobile Device, DiePlus, E2CMOS, Extreme Performance, FlashBAK, FlexiClock, 
flexiFLASH, flexiMAC, flexiPCS, FreedomChip, GAL, GDX, Generic Array Logic, HDL Explorer, iCE Dice, iCE40, 
iCE65, iCEblink, iCEcable, iCEchip, iCEcube, iCEcube2, iCEman, iCEprog, iCEsab, iCEsocket, IPexpress, ISP, 
ispATE, ispClock, ispDOWNLOAD, ispGAL, ispGDS, ispGDX, ispGDX2, ispGDXV, ispGENERATOR, ispJTAG, 
ispLEVER, ispLeverCORE, ispLSI, ispMACH, ispPAC, ispTRACY, ispTURBO, ispVIRTUAL MACHINE, ispVM, ispXP, 
ispXPGA, ispXPLD, Lattice Diamond, LatticeCORE, LatticeEC, LatticeECP, LatticeECP-DSP, LatticeECP2, 
LatticeECP2M, LatticeECP3, LatticeECP4, LatticeMico, LatticeMico8, LatticeMico32, LatticeSC, LatticeSCM, 
LatticeXP, LatticeXP2, MACH, MachXO, MachXO2, MachXO3, MACO, mobileFPGA, ORCA, PAC, PAC-Designer, 
PAL, Performance Analyst, Platform Manager, ProcessorPM, PURESPEED, Reveal, SensorExtender, SiliconBlue, 
Silicon Forest, Speedlocked, Speed Locking, SuperBIG, SuperCOOL, SuperFAST, SuperWIDE, sysCLOCK, 
sysCONFIG, sysDSP, sysHSI, sysI/O, sysMEM, The Simple Machine for Complex Design, TraceID, TransFR, 
UltraMOS, and specific product designations are either registered trademarks or trademarks of Lattice Semiconductor 
Corporation or its subsidiaries in the United States and/or other countries. ISP, Bringing the Best Together, and More of 
the Best are service marks of Lattice Semiconductor Corporation.

Other product names used in this publication are for identification purposes only and may be trademarks of their 
respective companies.
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